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THE NEWSLETTER IS BACK! WINTER 2015 

LAFAYETTE PARALEGAL 

ASSOCIATION , INC. 

RENEW YOUR MEMBERSHIP WITH LPA 

Membership Renewal Applications and 
Dues for the 2016-17 Membership Year are 
due March 1, 2016.   
 

Why Renew Your Membership? 
 
1. Access To Monthly Luncheon 

Seminars for Only the Cost of 
Your Meal 

Attend LPA Luncheons at the Petroleum 
Club once a month from 12 p.m. to 1:30 
p.m. for the cost of your meal and hear 
speakers on a variety of topics. CLE credit 
is available!  
This is really a huge benefit that LPA offers to 
it’s members. Comparing with other paralegal 
associations, you will notice that most other 
associations charge a significant fee for lectures 
that provide CLE credit. You will be able to keep 
up with NALA’s continuing education 
requirements just by attending our luncheons 
once a month. And you get a delicious meal out 
of it! 
 
2. Access to This Newsletter! 
Keep up with developments in our legal 
community and with LPA Activities by 
receiving free access to this newsletter. 
Newsletters are published seasonally. 
Do you have a story to share with LPA Members? 
Need to obtain some more CLE Credit? Have some 
tips that would help us out in our every day jobs? 
We would love to hear from you. Please contact 
our Newsletter Chair, Emma Guidry, at 
emmaguidry@allengooch.com for more 
information 

3. Eligibility for LPA’s Scholarship 
If you have been thinking of taking NALA’s 
CP or ACP or becoming a Louisiana Notary 
but decided it was too expensive, think 
again. LPA offers a scholarship to eligible 
active members up to $500 to cover the 
cost of testing fees, books, etc. For more 
information contact our Education/
Scholarship Chair, Deborah Fontenot, at 
debbiepfontenot@bellsouth.net or visit our 
website at lpa-la.org. 
 
4.  Networking and Social Events 
LPA provides an annual Paralegal Social and 
an annual Christmas Luncheon. We also 
offer opportunities twice a year to  
volunteer to beertend at Downtown Alive! 
(which is the most fun you will ever have as 
a paralegal!) Get to know other paralegals 
in the community! 
 
5. Access to LPA’s Job Bank 
Looking for a new job? For LPA members 
only, a job bank is provided on our website 
at www.lpa-la.org. You might just meet 
your next dream job!  
 
Click here to fill out a membership 
application for LPA. We look forward  
to seeing you!  

 

LPA offers great benefits to its members. Don’t forget to renew your membership on March 1 

IT’S THAT TIME OF YEAR ! 

Even if you completed an application in 
previous years, we need a new one with all 
of the blanks filled in since we do not 
retain applications from year to year 

mailto:emmaguidry@allengooch.com?subject=Newsletter
mailto:debbiepfontenot@bellsouth.net?subject=LPA%20Scholarship
http://www.lpa-la.org/
http://www.lpa-la.org
http://lpa-la.org/images/LPA_Membership_App_Revised_8-2014_-_interactive.pdf


lovely Christmas luncheon (even if 
Christmas was 80 degrees this year). The 
teddy bear drive was such a joyous way to 
end the year.  

While I will no longer be serving LPA as 
President for the 2016-17 season, I’m 
confident that LPA will continue to grow 
and serve the Paralegal community in such 
a useful way. 

Thanks for a great year, LPA! 

I think my favorite time of the year is the 
beginning. You have the entire year ahead 
of you, you don’t feel bogged down by the 
events of the previous year. It’s a time for 
reflection, plans, dreams, and inspiration.  

As the 2015-16 season of LPA comes to a 
close, I have the same feelings of renewal, 
reflection and peace. 2015 was a great year 
for LPA. Our membership grew 48%. We 
had a variety of interesting topics and 
speakers, good times at Downtown Alive, 
a successful Paralegal Week Social and a  

PRESIDENT ’S MESSAGE 
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NEW ETHICS OPINION ON SUBPOENAS 
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The American Bar Association issued a new opinion relating to the subpoena of client docu-
ments. Read the full opinion here. 

CHANGES TO THE RULES FOR MSJS 

TIME 

 A Motion for Summary Judgment and 
all documents in support shall be filed 
and served on all parties not less than 
65 days prior to trial 

 Oppositions to MSJ are now due 15 
days from the hearing  

 (previously 8) 

 Reply to Oppositions are now due 5 
days from the hearing  

 (previously 1) 

 No additional evidence can be included 
in the Reply Memorandum 

 If the date for filing the motion, 
opposition or reply memorandum falls 
on a legal holiday, the party has until 
the next day that is not a legal holiday 
to file the pleading and supporting 
documents 

 The contradictory hearing on the MSJ 
shall be set not less than 30 days after 
filing and not less than 30 days prior to 
trial  

 
OBJECTIONS 

 Any objection to a document shall be 
raised in a timely filed opposition or 
reply memorandum 

 Motion to Strike no longer valid means of 
raising on objection 

 Oral objections cannot be raised at the 
hearing 

 
EVIDENCE 

 The Court may consider only those 
documents filed in support of or in 
opposition to the MSJ 

 The Court shall consider any document to 
which no objection is made  

 The only documents that may be filed in 
support of or in opposition to the MSJ 
are: 

 Pleadings 

 Memoranda 

 Affidavits 

 Depositions 

 Answers to Interrogatories 

 Certified Medical Records 

 Written Stipulations 

 Admissions 
 
Read more about House Bill No. 696 (Act No. 
422 here. 

Effective January 1, 2016 

Be aware of the recent 
changes to  

La. C.C.P. Art. 966 
governing Motions for 
Summary Judgment 

Have you ever issued or received a subpoena for documents relating to a previous client? Here 
is some guidance from the ABA: 

 Attorney must notify the client of the demand; 

 Attorney must consult with client about how to respond; 

 Attorney should challenge the demand on any reasonable ground, if the client wishes; 

 Attorney should consult with the client regarding whether a fee will be charged for 
responding to the subpoena, but may still be required to challenge the initial demand even 
if no fee arrangement is agreed upon with the client; 

 If the client can’t be found, the attorney must “assert all reasonable objections and claims” 
when the initial demand is received. 

 
Louisiana’s Rule 1.6 for Confidentiality of Information follows the ABA Model. 

http://lalegalethics.org/wp-content/uploads/ABA-Formal-Opinion-re-SDT-to-Lawyer.pdf
https://www.legis.la.gov/legis/ViewDocument.aspx?d=879475
https://legis.la.gov/Legis/Law.aspx?d=112309
https://www.ladb.org/DR/Default.aspx?TAB=ROPC&DocID=ROPC1-6
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TEDDY BEARS FOR HEARTS OF HOPE 

Thanks to everyone who donated teddy bears for 
Hearts of Hope in December! As you can see, it was a 
huge success! 
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FORMATTING APPELLATE BRIEFS USING 

MICROSOFT WORD 

The References Tab of the ribbon is your 
best friend when it comes to marking all the 
citations for the Table of Authorities section 
of your brief. 
1. Make sure “Show Formatting” is 

turned on 
From the “Home” Tab, make sure the 
Paragraph symbol is selected. This allows 
you to view all paragraph and formatting 
marks and is necessary to view the citations 
you are marking along the way 

 
 
 
 
 

 
 
 

2. As you work your way through 
the brief, mark the citations 

To mark a citation, select it and click “Mark 
Citation” on the References Tab 

 
 
 
 

3. A dialogue box will pop up to 
allow you to select the type of 
citation 

Select the correct category from the dialogue 
box—Cases, Statues, Rules, etc. 

 
 
 

4. Create the Table of Authorities 
From the References Tab, insert the Table of 
Authorities 
 
 
 
 
 
 
 
To format the TOA, right click and select 
“Edit Field”, then click the “Table of 
Authorities” button 

Then click the “Modify” button to change the 
font, spacing, etc. 
 
 
 

 
 
 
 
 
To update the page numbers on the Table of 
Authorities, right click and select “Update 
Field”. It will automatically update your page 
numbers. 
 
Click these links for great resources on the Table of 
Contents and Table of Authorities 

PART 2—TABLE OF AUTHORITIES 

 

The way the text appears 
in this box is the way it 
will appear in your Table 
of Authorities, so change 
it if necessary 

http://legalofficeguru.com/inserting-a-table-of-contents-using-styles/
http://legalofficeguru.com/inserting-a-table-of-contents-using-styles/
http://legalofficeguru.com/table-of-authorities-marking-citations/


 

Federal Judge James Carr of the Northern District of Ohio issued an Order to Show 
Cause why he hadn’t committed fraud on the Court. The disbarred attorney, Stan 
Chesley, allegedly failed to comply with a state court order to return cash to plaintiffs 
who had over-paid attorney’s fees to him. 
Some of the highlights of the opinion include: 
 “Most simply put: had I known but a fraction of what I did not know before dismissal I 

would have acted differently. Under no circumstances would I have accepted a settlement 
that enabled Chesley...to evade the obligation to pay over the settlement proceeds...”   

 
 “[I]n a word, at this point, I feel tricked, and complicit, albeit unwittingly so, in 

chicanery, duplicity, and mendacity. No judge should ever find himself in that 
situation. 

Read the entire opinion here. 

JUDGE TRICKED BY DISBARRED ATTORNEY 

ETHICS CORNER 
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A lawyer can ethically “BCC” a client in corresponding with 
opposing counsel 

The New York State Bar Association Committee on Professional Ethics recently 
encountered this very issue  when an attorney “BCC’d” his client in an email to opposing counsel over the 
opposing counsel’s objection to such practices. The Committee opined that a lawyer does not owe the 
same duties of loyalty and confidentiality to opposing counsel as he does to his client. They further opined 
that this is not a “false, misleading or deceptive” practice and in fact the lawyer has an obligation to keep 
the client reasonably informed, so opposing counsel should expect that the attorney would  share 
correspondence relating to the representation of his client. Read the entire opinion here. 

However, be careful that  the “reply all” issue might rear it’s ugly head if the client accidently hits the 
button.  

Subject-Verb Agreement: When using “either...or” or “neither...nor”, the verb agrees in number 
with the subject closest to it 
 Neither the paralegals nor their boss was available to talk to the client.   
 
Who vs. Which vs. That: Use “who” for all clauses related to people, “which” for all nonrestrictive 
clauses related to things, and “that” for all restrictive clauses related to things 
 The person who helped me with my homework was nice. 
 The keys, which I couldn’t find, open the door to the shed.  
 The keys that open the shed are lost. 
 
What the heck is a gerund?: A verb form ending in “-ing” that acts as a noun. 
 Your snoring woke me up last night. 

GRAMMAR REVIEW 

A refresher to avoid common grammar errors 

WELCOME NEW 

MEMBERS ! 

 

 Lorna Sennet 

 Shannon Randall 

 Jaleesa Randle 

 Melissa Boyher 

 Nikki Cerossie 

http://abovethelaw.com/2016/02/federal-judge-prepared-to-issue-benchslap-after-getting-duped-by-disbarred-rainmakers-shenanigans/2/?rf=1
http://www.nysba.org/CustomTemplates/Content.aspx?id=60757


 

RECENT SEMINARS 
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Greg Mier, J.D., Attorney with the Onebane Law Firm, gave a presentation on the 
fundamentals of U.S. Immigration Law.  

Mr. Mier is a registered patent attorney specializing in Intellectual Property Law and 
Immigration Law. 

November 19, 2015 
Immigration Law:  The Fundamentals—Greg Mier 

January 28, 2016 
IRS Tax Resolution: Real Life Cases—Jessica Thibodeaux 

Jessica Thibodeaux, attorney with The Bryson Law Firm gave a short lecture on tax law. She 
discussed IRS problem solving tactics (collection alternatives), unfiled tax returns, levies & 
garnishments, currently non-collectable status, liens, innocent spouse, offer in compromise, 
installment agreements, and penalty abatements.  

She also handed out a “Cheat Sheet” of IRS Notices and what they refer to. 
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2015 CHRISTMAS LUNCHEON 

This year’s Christmas Luncheon at the City Club in River 
Ranch was also a tremendous success, despite it being close to 
80 degrees outside! We had a fabulous meal, learned about 
Hearts of Hope and also gave out door prizes. 



PAGE 10 LAFAYETTE PARALEGAL ASSOCIATION , INC .  



EMMA GUIDRY ,  CP, LCP,  

PRESIDENT 

MEAGAN SPENCER ,  

SECRETARY 

M ICHELLE DOMAS ,   

V ICE-PRESIDENT 
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2015-16 OFFICERS 

SAVANNAH STEPHAN ,  CLA 

TREASURER 

LESLEY S IMON ,  

PARLIAMENTARIAN 

MARANDA P ILLSBURY ,  

CORRESPONDING SECRETARY 

Allen & Gooch, APLC 
P.O. Box 81129 
Lafayette, LA 70598-1129 
(337) 291-1402 
emmaguidry@allengooch.com 

Law Offices of Thomas R. Hightower, Jr. 
1019 Lafayette Street 
Lafayette, LA 70505 

(337) 233-0555 
sps@trhaplc.com  

Ottinger Hebert, LLC 
1313 W. Pinhook Road 
Lafayette, LA 70503 
(337) 232-2606 
mmdomas@ohllc.com 

Vermilion Parish School Board 
220 S. Jefferson Street 

Abbeville, LA 70510 
(337) 898-5777 

lesley.simon@vpsb.net 

Briney Foret Corry 
413 Travis Street 
Lafayette, LA 70502 
(337) 237-4070 
mospencer@brineyforet.com 

110 Bacon Lane 
Carencro, LA 70520 

(337) 654-9759 
maranda.pillsbury@yahoo.com 

2015-16 COMMITTEE CHAIRS 

Education/Scholarship:  
Deborah Fontenot 
debbiepfontenot@bellsouth.net 

Membership: 
Michelle Domas 
mmdomas@ohllc.com 

Finance: 
Savannah Stephan 
sps@trhaplc.com 

Public Relations: 
Savannah Stephan 
savannahs@cox.net 

Program/LBA Liaison: 
Kaye Pooler 
poolerk@bellsouth.net 

Newsletter: 
Emma Guidry 
emmaguidry@allengooch.com 

Technical/Web Page: 
Maranda Pillsbury 
maranda.pillsbury@yahoo.com 

Social: 
Nancy McMillan 
nmcmillan@mandllaw.com 

Photography: 
Cheryl Dubois 
cdubois917@gmail.com 

mailto:emmaguidry@allengooch.com
mailto:sps@trhaplc.com
mailto:mmdomas@ohllc.com
mailto:lesley.simon@vpsb.net
mailto:mospencer@brineyforet.com
mailto:maranda.pillsbury@yahoo.com
mailto:debbiepfontenot@bellsouth.net
mailto:mmdomas@ohllc.com
mailto:sps@trhaplc.com
mailto:savannahs@cox.net
mailto:poolerk@bellsouth.net
mailto:emmaguidry@allengooch.com
mailto:maranda.pillsbury@yahoo.com
mailto:nmcmillan@mandllaw.com
mailto:cdubois917@gmail.com


The Lafayette Paralegal Association (LPA) was organized in 1984 by a group of 

paralegals attempting to identify goals and objectives common to the paralegal  

profession. Bylaws were formulated and, in 1985, the first officers were elected and 

committees formed in order to implement the goals and objectives of the  

association.  

In 1999, LPA became a not-for-profit corporation.  

 

The number of paralegals in the workforce has more than doubled in recent years, 

and so has LPA membership. Four classifications of membership are available: 

 

Active [voting] 

Student [non-voting] 

Associate [non-voting] and 

Sustaining [sponsor, non-voting] 

 

LPA continues to pursue the goals identified by its charter members by: 

 Offering continuing education through its monthly luncheon seminars;  

 Participating in activities with other organizations in the legal community 

 Encouraging national certification 

 

Want to learn more?  

Contact our President, Emma Guidry, at emmaguidry@allengooch.com  

Or visit us on the web at www.lpa-la.org 

P.O. Box 2775 
Lafayette, LA 70502-2775 

 

 

LAFAYETTE PARALEGAL ASSOCIATION ,  INC . 

THANKS TO OUR SUSTAINING MEMBERS! 

PROFESSIONALISM FIRST . . . 

WE ’RE ON THE WEB ! 

WWW .LPA-LA .ORG 

mailto:emmaguidry@allengooch.com
http://www.lpa-la.org
http://www.lpa-la.org
http://www.brineyforet.com/
http://www.loriheaphy.com/
http://www.onebane.com/
http://www.bayouinvestigations.com/
http://www.ottingerhebert.com/
http://www.prolegalcopies.com/
http://www.duboisimages.com/
http://www.brysonlawfirm.com/
http://www.mandloffice.com/Mahtook_%26_LaFleur/Home.html
mailto:davidscook@bellsouth.net
http://www.lafayettebar.org/
https://www.linkedin.com/company/lafayette-paralegal-association
https://www.facebook.com/lafayetteparalegalassociation

